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Uvod 

 Zmogljiv vsestranski grafični kalkulator  

 

 Številna orodja (Toolboxes), knjižnice z vgrajenimi funkcijami 

 

 Obdelava velikih zbirk podatkov  

 

 Kompleksne numerične kalkulacije 

 

 Vizualizacija podatkov  z različnimi grafi 
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Matlab okolje 

1. Ukazno okno (Command window) 

2. Zgodovina (Command history) 

3. Brskalnik (Current folder browser) 

4. Delovno okolje (Workspace) 

Matlab okolje 
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Ukazno okno (Command window) 

 Osrednje okno programa 

 

 Vnos ukazov 

Matlab okolje 
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Zgodovina (Command history) 

 Običajno spodaj desno 

 Samodejno spremljanje/shranjevanje vnesenih 

ukazov  

 Pregled nad predhodno vnesenimi ukazi (tudi za 

več sej nazaj)  

 

Matlab okolje 



Univerza v Ljubljani  ..: Fakulteta za elektrotehniko:.. 

[LDOS]   ..: Laboratorij za digitalno obdelavo signalov, slik in videa:.. 

Trenutna mapa (Current folder) 

 Okence v orodni vrstici  

 Izpis lokacije in poti trenutne delovne mape  

 Trenutna mapa = mapa, kamor se shranjuje delo 

(funkcije, datoteke, …)  

 Za spremembo te  

 mape klikni na  

 ’’Browse’’ gumb  

 

Matlab okolje 
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Brskalnik (Current folder browser)  

 Prikazuje vsebino trenutne mape 

 S spreminjanjem prikazane mape v brskalniku 

spreminjamo tudi trenutno mapo za shranjevanje 

našega dela 

 Navigacija je enaka kot pri Win Explorerju 

Matlab okolje 
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Delovno okolje (Workspace browser) 

 Nad zgodovino 

 V delovnem okolju so shranjeni podatki vaše trenutne seje – 

rezultati vnesenih ukazov  

 Se zbriše, ko zapremo program 

Matlab okolje 
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Matlab osnove 

1. Osnovni računski postopki  

– Matlab kot kalkulator  

– Ustvarjanje spremenljivk  

– Lociranje podatkov v Matlabu  

– Pregledovanje vsebine 

spremenljivk  

 

2. Ustvarjanje polj  

– Ustvarjanje vektorjev  

– Ustvarjanje matrik  

3. Urejanje polj  

– Indeksiranje elementov v poljih  

– Operator podpičja (:)  

 

4. Računanje s polji  

– Matrične operacije  

– Lastne vrednosti matrike 

– Operacije nad polji  

 

5. Vizualizacija matematičnih 

funkcij   
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Osnovni računski postopki 

 Matlab kot kalkulator 

– Programabilen  

– Delo s funkcijami – vhodne parametre podajamo v okroglih 

oklepajih 

• Iskanje: Matlab Help! (tipka F1, ukaz doc, ikona z vprašajem v orodni vrstici) 

– Razporeditev po kategorijah (npr. Mathematics) in podkategorijah (npr. Linear 

Algebra)  

– Podana je sintaksa, osnovni primeri, itd.  

 

 

Matlab osnove – osnovni računski postopki 
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Matlab kot kalkulator - primer 

Naloga: poišči vgrajeno funkcijo s katero 

lahko izračunamo tretji koren 

spremenljivke a.  

Matlab osnove – osnovni računski postopki 
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Matlab kot kalkulator - naloga 

Izračunajte naslednje vrednosti 

Matlab osnove – osnovni računski postopki 

𝑓 =
33 + 53

2

3 ∙ 19
3   

𝑑 =  𝑒−
1
5 

𝑟 = 𝑒3 ∙ sin
3𝜋

4
 

𝑧 = 𝑓 + 𝑑2 + 𝑟3 
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Kje so rezultati?  

 Shranjeni v pomnilniku kot 

spremenljivke – podatkovni zabojniki 

  

 Spremenljivke = matrike (polja) 

  

 Atributi:  

– Velikost (m x n x p) 

– Tip (double, single, cell, …)  

 

Matlab osnove – osnovni računski postopki 
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Ustvarjanje spremenljivk 

 Shranjene spremenljivke 

lahko uporabimo pri nadaljnjih 

izračunih  Ime 

spremenljivke 

(case sensitive!) 

Prireditveni 

operator 
Vrednost 

Primer: 

Sintaksa: 

Matlab osnove – osnovni računski postopki 
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Ustvarjanje spremenljivk – sintaktični primeri 

Matlab osnove – osnovni računski postopki 
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Lociranje in dostop do podatkov 

Workspace Browser 

Matlab osnove – osnovni računski postopki 
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Lociranje in dostop do podatkov 

Z dvoklikom na spremenljivko jo 

prikažemo v Urejevalniku 

spremenljivk (Variable Editor) 

Urejevalnik spremenljivk:  

Prikazuje vsebino spremenljivk, ki 

jo lahko tudi spreminjamo.  

Matlab osnove – osnovni računski postopki 
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Ustvarjanje polj – vektorjev   

 Vektor = polje ena od dimenzij je enaka 1  

 2 osnovni metodi za ustvarjanje vrstičnih vektorjev 1 x n:  

– Operator :  

>> x = a:dx:b 

– Ukaz linspace  

>> x = linspace(a,b,n) 

 Stolpčni vektor (n x 1) dobimo s transponiranjem – operator '  

>> x = x′    

 Namig: podpičje na koncu izraza prepreči izpis ustvarjenega polja v 

ukaznem oknu  preglednejše okno in hitrejše delovanje 

 Primer: na oba načina ustvarite vektor x med 0 in 6 z dolžino 

intervala 2.  

Matlab osnove – ustvarjanje polj 

vrednosti 
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Ustvarjanje matrik 

 2D polja  

 Matriko lahko vnesemo ročno:  

– vrednosti podamo v oglatih 

oklepajih  

– Vrednosti se vnašajo po vrsticah 

– Ločevanje stolpcev: , ali 

presledek  

– Ločevanje vrstic: ; ali enter 

 Vnos z uporabo funkcij ones, 

zeros, rand  

 

Matlab osnove – ustvarjanje polj 
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Urejanje polj  

>> A = [1 2 3; 4 5 6; 7 8 9] 

 

 Indeksiranje  

>> k = A(2,3) 

>> blok1 = A(2, [1 2]) 

 Operator dvopičja (colon) – :  

>> blok2 = A(2, 1:2) 

>> vrstica2 = A(2,:) 

 Sestavljanje matrik  

>> B = [A ; A] 

 Transponiranje  

>> Atrans = A′    

 Vgrajeni ukazi: sort, reshape, flipud  

Matlab osnove – urejanje polj 



Univerza v Ljubljani  ..: Fakulteta za elektrotehniko:.. 

[LDOS]   ..: Laboratorij za digitalno obdelavo signalov, slik in videa:.. 

Matrične operacije 

 Vse spremenljivke so matrike! 

 

 Pravila pri uporabi matematičnih operacij:  

– Množenje: ujemanje notranjih dimenzij faktorjev 

– Seštevanje in odštevanje: popolno ujemanje dimenzij  

 

 Poseben primer: računske operacije z matriko (1 x 1), ki je 

obravnavana kot skalar 

Matlab osnove – računanje s polji 



Univerza v Ljubljani  ..: Fakulteta za elektrotehniko:.. 

[LDOS]   ..: Laboratorij za digitalno obdelavo signalov, slik in videa:.. 

Osnovne operacije s skalarno vrednostjo  

Množenje s skalarjem  Prištevanje skalarja Množenje matrik 

Matlab osnove – računanje s polji 



Univerza v Ljubljani  ..: Fakulteta za elektrotehniko:.. 

[LDOS]   ..: Laboratorij za digitalno obdelavo signalov, slik in videa:.. 

Primer: sistem linearnih enačb 

Določite vrednosti vektorja x! 

Matlab osnove – računanje s polji 
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Primer: lastne vrednosti matrike 

 Za vsako matriko lahko 
določimo njen karakteristični 
polinom 

 

 Funkcija poly – koeficienti 
karakterističnega polinoma  

 

 Funkcija roots – poišče 
korene karakterističnega 
polinoma = lastne vrednosti  

 

 Funkcija eig – direktna pot do 
lastnih vrednosti in vektorjev  

Matlab osnove – računanje s polji 
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Operacije nad polji  

 Delujejo na nivoju istoležnih elementov  

 Ujemanje velikosti mora biti popolno  

 Pred računski operator vstavimo piko 

Seštevanje polj Množenje polj Potenciranje polj 

Matlab osnove – računanje s polji 
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Množenje polj vs množenje matrik 

Matlab osnove – računanje s polji 
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Vizualizacija matematičnih funkcij 

Za izris funkcije x sta 2 možnosti:  

– Interaktivno prek delovnega 

okolja  

• Z uporabo Ctrl označimo med 

spremenljivkami tisti dve, ki ju 

želimo izrisati na 2D diagram – t 

in x  

• Nato v orodni vrstici delovnega 

okolja uporabimo bljižnico za 

izris  

– Z uporabo vgrajene funkcije 
plot prek ukaznega okna:  

>> plot(t,x) 

Matlab osnove – vizualizacija funkcij 
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Uporaba vgrajenih funkcij 

 Sintaksa:  
– Ime_funkcije(parameter1, parameter2, …) 

 

– Vhodne parametre funkcij zmeraj podajamo v oklepajih  

• Primer: >> plot(t,x) 

 

– Rezultat funkcije lahko priredimo poljubni izhodni spremenljivki  

• Primer: >> y = cos(pi/4)  

 

 

Matlab osnove – vizualizacija funkcij 
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Naloga 

Primer dušenega nihanja:  

 

 

 

 

 

 

 

 

 

Izriši graf (t, x(t))! 

 

𝑧 = 0.1 
𝑤𝑛 = 10  

𝑤𝑑 = 𝑤𝑛 1 − 𝑧2 

𝑥0 = 10 

 

Nariši: 

𝑥 𝑡 = 𝑥0𝑒−𝑧𝑤𝑛𝑡
𝑧

1 − 𝑧2
sin(𝑤𝑑𝑡) + cos(𝑤𝑑𝑡)  

𝑡 = 0 ÷ 5 𝑠 

Matlab osnove – vizualizacija funkcij 
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Matlab osnove - povzetek 

 Osnovni računski postopki  

 

 Delo s polji – matrikami  

– Ustvarjanje  

– Urejanje  

– Računanje  

 

 Vizualizacija rezultatov (matematičnih funkcij) 

Matlab osnove 
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Reševanje problemov z Matlabom 

 Uvoz podatkov  
(wav, txt, csv, slikovne datoteke itd.) 

 Vizualizacija podatkov  

 Numerična analiza  
– Prilagajanje krivulj  

– Avtomatska analiza s skriptami  

– Objava rezultatov  

 

 Primeri:  
– Simulacije (omrežij, posameznih delov ali nivojev omrežij, prenosa 

podatkov itd.)  

– Modeliranje in generiranje signalov, šuma  

– Implementacija različnih modulacijskih tehnik 

– Obdelava signalov (slike, video itd.)  

– Fuzija podatkov  

– Vizualizacija  
 

Reševanje problemov 
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Uvoz podatkov  

 Čarovnik za uvoz podatkov  

 

 Programirani uvoz podatkov  

 

 Pridobivanje zanimivih podatkov  

– Naslavljanje vrstic in stolpcev  

 

 Shranjevanje in odpiranje podatkov  

Reševanje problemov – uvoz podatkov 
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Čarovnik za uvoz podatkov 

 Zagon:  

– File>Import Data …  

– Desni klik na izbrano datoteko 

v brskalniku trenutne 

mape>Import Data …   

 

 Parametri 

– Separator stolpcev, imena 

spremenljivk  

 

 Uvoženi podatki se shranijo v 

delovno okolje trenutne seje  

 Uporabno za enkraten uvoz  

 Osveževanje podatkov  

sprogramiran ponavljajoč se 

uvoz  

Reševanje problemov – uvoz podatkov 
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Programirani uvoz podatkov 

 Avtomatizacija uvažanja podatkov  

 Primerno za podatke, ki se nenehno osvežujejo (senzorji, 

podatkovne baze itd.) 

 Funkcija importdata (čarovnik brez UI)  

 Podprti formati za uvoz:  

>> doc fileformats  

 Druge funkcije za specifičen tip podatkov:  
– textread  

– imread  

– wavread 

– uiimport  

– xlsread  

– input  

Reševanje problemov – uvoz podatkov 
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Naloga 

Uvozite podatke iz datoteke L_cikel1_data_antena.txt 

(med gradivi predmeta na spletu).   

 

Uporabite interaktivni način in način preko ukaznega okna.  

Reševanje problemov – uvoz podatkov 
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Pridobivanje zanimivih podatkov 

 Podatki podani v obliki večjih 
večdimenzionalnih matrik  

 

 Delo s podatki:  

– Zanima nas le del vseh 
podatkov  

– Podatke želimo razvrstiti za 
lažje nadaljnje delo  

 

 Dve možnosti:  

– Urejanje v urejevalniku 
spremenljivk  

– Urejanje s funkcijami prek 
ukaznega okna 

 

Reševanje problemov – uvoz podatkov 
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Urejevalnik spremenljivk 

 Izbrano spremenljivko odpremo 
v urejevalniku (dvoklik)  

 

 Izberemo del, ki nas zanima in 
ga želimo prenesti v novo 
spremenljivko  

 

 Z desnim klikom na izbrani del 
odpremo meni  Create 
Variable from Selection 

 

 Nazadnje izberemo še ime nove 
spremenljivke 

 

 Izberemo lahko celoten stolpec 
ali vrstico (podobno kot v Excel-
u) 

Reševanje problemov – uvoz podatkov 
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Urejanje prek ukaznega okna 

 Naslavljanje po vrsticah in stolpcih – dostop do posameznih 
elementov matrik  

 Začetek štetja z 1 

Indeksi   Podatki 

Reševanje problemov – uvoz podatkov 
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Naslavljanje po vrsticah in stolpcih 

Naslavljanje posameznega elementa 

Indeksi   Podatki 

Ime_spremenljivke(vrstica,stolpec) 

Reševanje problemov – uvoz podatkov 
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Naslavljanje po vrsticah in stolpcih 

Z uporabo dvopičja lahko naslovimo izbrani obseg vrstic ali stolpcev  

Indeksi   Podatki 

Ime_spremenljivke(vrstica,stolpec) Ime_spremenljivke(vrstica,stolpec) 

Reševanje problemov – uvoz podatkov 
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Naslavljanje po vrsticah in stolpcih 

Z uporabo dvopičja lahko naslovimo celotne vrstice in/ali stolpce 

Ime_spremenljivke(vrstica,stolpec) 

Indeksi   Podatki 

Reševanje problemov – uvoz podatkov 
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Naloga 

Podana je naslednja matrika:  

 
17 24 1 8 15
23 5 7 14 16
4 6 13 20 22

10 12 19 21 3
11 18 25 2 9

 

 

 Z naslavljanjem izpiši zadnji element matrike  

 V urejevalniku spremenljivk ustvari spremenljivko, ki bo zajemala vrstic 
3 in 4 ter stolpce 3 – 5. Nalogo ponovi še z uporabo naslavljanja.  

Reševanje problemov – uvoz podatkov 
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Shranjevanje in odpiranje podatkov  

Shrani  

Odpri 

Reševanje problemov – uvoz podatkov 
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Shranjevanje in odpiranje podatkov  

 Shranjevanje preko delovnega okolja  

– Izberemo eno ali več spremenljivk v delovnem okolju  

– Desni klik  Save as …  

– Spremenljivka/-e se shranijo kot .mat datoteka v trenutno mapo 
(brskalnik)  

 

 Shranjevanje preko ukaznega okna  
– >> save (ime_datoteke,ime_spremenljivke1, …)  

– Če uporabimo samo save, se shranijo vse spremenljivke v delovnem 
okolju kot datoteka matlab.mat  

 

 Odpiranje  

– Dvoklik na izbrano datoteko v brskalniku trenutne mape  

– Uporabimo load(ime_datoteke) v ukaznem oknu 
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Univerza v Ljubljani  ..: Fakulteta za elektrotehniko:.. 

[LDOS]   ..: Laboratorij za digitalno obdelavo signalov, slik in videa:.. 

Uvoz podatkov - povzetek 

 Uporaba čarovnika za uvoz podatkov  

 

 Uporaba programiranega uvoza podatkov  

 

 Pridobivanje zanimivih podatkov z naslavljanjem vrstic in stolpcev  

 

 Shranjevanje in odpiranje podatkov  

 

Reševanje problemov – uvoz podatkov 



Univerza v Ljubljani  ..: Fakulteta za elektrotehniko:.. 

[LDOS]   ..: Laboratorij za digitalno obdelavo signalov, slik in videa:.. 

Vizualizacija podatkov 

 

„Slika pove več kot 1000 besed!“  
 

 Boljše razumevanje konceptov 

 

 Bolj učinkovito sporočanje rezultatov in ugotovitev  

 

 Dva osnovna načina za ustvarjanje in spreminjanje grafov:  

– Uporaba interaktivnih orodij  

– Uporaba ukaznega okna (plot) 

Reševanje problemov – vizualizacija podatkov 



Univerza v Ljubljani  ..: Fakulteta za elektrotehniko:.. 

[LDOS]   ..: Laboratorij za digitalno obdelavo signalov, slik in videa:.. 

Komponente grafa  

Okno grafa 

title 

Osi 

ylabel 

xlabel 

Črtni graf 

legend 

Reševanje problemov – vizualizacija podatkov 



Univerza v Ljubljani  ..: Fakulteta za elektrotehniko:.. 

[LDOS]   ..: Laboratorij za digitalno obdelavo signalov, slik in videa:.. 

Vizualizacija matematičnih funkcij 

Za izris funkcije x sta 2 možnosti:  

– Interaktivno prek delovnega 

okolja  

• Z uporabo Ctrl označimo med 

spremenljivkami tisti dve, ki ju 

želimo izrisati na 2D diagram – t 

in x  

• Nato v orodni vrstici delovnega 

okolja uporabimo bljižnico za 

izris  

 

– Z uporabo vgrajene funkcije 
plot prek ukaznega okna:  

>> plot(t,x) 

Reševanje problemov – vizualizacija podatkov 



Univerza v Ljubljani  ..: Fakulteta za elektrotehniko:.. 

[LDOS]   ..: Laboratorij za digitalno obdelavo signalov, slik in videa:.. 

Interaktivno urejanje - plottools 

 Interaktivna orodja za urejanje grafov:  ukaz plottools v ukaznem 
oknu 

Dodajanje 

podoken, 

pregled 

spremenljivk 

Legenda, sledenje 

posameznim 

grafom, dodajanje 

novih grafov 

Lastnosti objektov 

grafa (črte, barva 

itd.) 

Dock/Undock 

(ko končamo z urejanjem) 
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Univerza v Ljubljani  ..: Fakulteta za elektrotehniko:.. 

[LDOS]   ..: Laboratorij za digitalno obdelavo signalov, slik in videa:.. 

Naloga  

 Na graf iz prejšnje naloge 

dodaj graf poteka dušenja:  

 

𝑑𝑢𝑠𝑒𝑛𝑗𝑒 = 𝑥0 ∗ 𝑒−𝑧𝑤𝑛𝑡 

 

 Graf dušenja naj bo označen z 

rdečo črtkano črto  

 Ustrezno označite naslov, osi 

in legendo grafa.  
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Odziv sistema

Dušenje amplitude
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Univerza v Ljubljani  ..: Fakulteta za elektrotehniko:.. 

[LDOS]   ..: Laboratorij za digitalno obdelavo signalov, slik in videa:.. 

Urejanje s funkcijo plot 

 Osnovni graf:  
>> plot(t,x)  

 

 Za dodajanje novih grafov na obstoječega moramo uporabiti ukaz 
hold on/off  

 

 Za urejanje oblike črt v grafih uporabimo dodatne parametre v funkciji 
plot (LineSpec parametri), npr:  
>> plot(t,x,‘r:‘)  

 

 Za urejanje naslova, imen osi in legende imamo na voljo funkcije title, 
xlabel, ylabel, legend  

Primer:  >> xlabel('Čas[s]')  

 

 Dodatni parametri – dokumentacija (Help)  

 

 Druge funkcije za risanje grafov: surf, imagesc, colormap, contour  

Reševanje problemov – vizualizacija podatkov 



Univerza v Ljubljani  ..: Fakulteta za elektrotehniko:.. 

[LDOS]   ..: Laboratorij za digitalno obdelavo signalov, slik in videa:.. 

Vizualizacija – povzetek  

 Komponente grafa v Matlabu  

 

 Uporaba interaktivnih orodij za risanje grafov  

 

 Risanje grafov s funkcijo plot  
 

Reševanje problemov – vizualizacija podatkov 



Univerza v Ljubljani  ..: Fakulteta za elektrotehniko:.. 

[LDOS]   ..: Laboratorij za digitalno obdelavo signalov, slik in videa:.. 

Numerična analiza  

 Vgrajene funkcije  

– Uporaba  

 

 Analiza podatkov 

– Prilagajanje krivulj  

– Avtomatizacija s skriptami  

– Objava rezultatov 

Reševanje problemov – numerična analiza 



Univerza v Ljubljani  ..: Fakulteta za elektrotehniko:.. 

[LDOS]   ..: Laboratorij za digitalno obdelavo signalov, slik in videa:.. 

Vgrajene funkcije 

 Seznam vgrajenih funkcij:  

– Help>Functions> 

By Category 

Alphabetical 

– Ukaz doc v ukaznem oknu  

– Klik na simbol fx v ukaznem oknu  

 

 Razdelitev na kategorije:  

– Elementarne matematične (Elementary Math Functions) – doc elfun 

– Elementarne statistične (Elementary Statistical Functions) – doc 
datafun 

– Matrične (Matrix Functions) – doc elmat 

– Napredne matematične (Advanced Math Functions) – doc specfun 

– Glede na temo (All functions by topic) – helpwin  
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Univerza v Ljubljani  ..: Fakulteta za elektrotehniko:.. 

[LDOS]   ..: Laboratorij za digitalno obdelavo signalov, slik in videa:.. 

Uporaba funkcij – osnovna sintaksa  

 Vhodne parametre funkcije vedno 
podajamo v (okroglih) oklepajih 
za njenim imenom  

 

 Vhodni parametri so lahko 
konkretne vrednosti (števila, 
besedilni nizi, matrike itd.) ali pa 
spremenljivke iz delovnega okolja 
– Gnezdenje funkcij: rezultat neke 

funkcije je lahko vhodni 
parameter druge funkcije 

 npr: >> a=abs(cos(pi)) 

 

 Izhodno vrednost funkcije lahko 
priredimo novi/izbrani 
spremenljivki  

 

 Če nismo prepričani o sintaksi  
Help 

Izhod = Ime_Funkcije(vhod)* 

* Vhodnih parametrov je lahko tudi 

več. Med sabo jih ločimo z vejicami. 
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Univerza v Ljubljani  ..: Fakulteta za elektrotehniko:.. 

[LDOS]   ..: Laboratorij za digitalno obdelavo signalov, slik in videa:.. 

Prilagajanje krivulj  

 Interpolacija nad izmerjenimi podatki – ocena stanja med 
izmerjenimi vrednostmi  

 Dokazovanje, vrednotenje (matematičnih) predpostavk 

 Modeliranje empiričnih podatkov  

 

 Možnosti v Matlabu:  

– Basic Fitting Tool  

– Curve Fitting Toolbox  

– Spline Toolbox (spline = zlepek)  

 

 Spoznali bomo:  

– Basic Fitting Tool  

– Interaktivno prilagajanje krivulj  

– Pridobivanje koeficientov  

– Osnovni ukazi prilagajanja krivulj 

Reševanje problemov – numerična analiza 



Univerza v Ljubljani  ..: Fakulteta za elektrotehniko:.. 

[LDOS]   ..: Laboratorij za digitalno obdelavo signalov, slik in videa:.. 

Basic Fitting Tool (BFT) 

 V oknu grafa, nad katerim želimo izvesti prilagajanje krivulj izberemo: 
Tools>Basic Fitting  
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Univerza v Ljubljani  ..: Fakulteta za elektrotehniko:.. 

[LDOS]   ..: Laboratorij za digitalno obdelavo signalov, slik in videa:.. 

Basic Fitting Tool (BFT)  

 Izbiramo lahko med različnimi možnostmi prilagajanja krivulj (linearno, 
kvadratično, kubično, s polinomi višjih redov) 

 Možen je tudi izpis enačbe prilagojene krivulje in s tem njena nadaljnja 
uporaba 

Reševanje problemov – numerična analiza 



Univerza v Ljubljani  ..: Fakulteta za elektrotehniko:.. 

[LDOS]   ..: Laboratorij za digitalno obdelavo signalov, slik in videa:.. 

BFT – pridobivanje koeficientov  

 V spodnjem desnem kotu 

kliknemo na puščico in 

razširimo vmesnik BFT  

  prikažejo se tudi koeficienti 

polinoma  

 Izberemo Save to workspace – 

v novem oknu izberemo imena 

 OK  

 Izbrane vrednosti se shranijo v 

delovno okolje 
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Univerza v Ljubljani  ..: Fakulteta za elektrotehniko:.. 

[LDOS]   ..: Laboratorij za digitalno obdelavo signalov, slik in videa:.. 

Ukazi osnovnega prilagajanja 

 Polinomsko prilagajanje iz 
orodja BFT lahko 
nadomestimo s funkcijama 
polyfit in polyval v 
ukaznem oknu 

 

 Polyfit: pridobitev 
koeficientov  

 

 Polyval: določitev funkcijskih 
vrednosti za določene 
koeficiente in podano 
funkcijsko območje 

>>  

>> plot(razdalja,moc,'r.') 

>> hold on 

>> p=polyfit(razdalja,moc,4) 

 

p = 

 

    0.0000   -0.0050    0.2045   

-3.8877   34.2527 

 

>> y=polyval(p,razdalja); 

>> plot(razdalja,y,'b-') 

Reševanje problemov – numerična analiza 



Univerza v Ljubljani  ..: Fakulteta za elektrotehniko:.. 

[LDOS]   ..: Laboratorij za digitalno obdelavo signalov, slik in videa:.. 

Ukazi osnovnega prilagajanja 

 Polinomsko prilagajanje iz 
orodja BFT lahko 
nadomestimo s funkcijama 
polyfit in polyval v ukaznem 
oknu 

 Polyfit: pridobitev koeficientov  

 Polyval: določitev funkcijskih 
vrednosti za določene 
koeficiente in podano 
funkcijsko območje 

>>  

>> plot(razdalja,moc,'r.') 

>> hold on 

>> p=polyfit(razdalja,moc,4) 

 

p = 

 

    0.0000   -0.0050    0.2045   

-3.8877   34.2527 

 

>> y=polyval(p,razdalja); 

>> plot(razdalja,y,'b-') 
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Univerza v Ljubljani  ..: Fakulteta za elektrotehniko:.. 

[LDOS]   ..: Laboratorij za digitalno obdelavo signalov, slik in videa:.. 

Naloga  

 Izvedite polinomsko 
interpolacijo za dano tabelo  

 

 Interpolacijski polinom naj 
bo 4. stopnje  

 

 Določite koeficiente 
interpolacijskega polinoma  

 

 Narišite polinom in napišite 
njegov analitični izraz 

 

 Izračunajte y(-0.2) 

 

x y 

-1 -1 

0.5 3 

1 2 

2.3 4.5 

2.5 6 

Reševanje problemov – numerična analiza 



Univerza v Ljubljani  ..: Fakulteta za elektrotehniko:.. 

[LDOS]   ..: Laboratorij za digitalno obdelavo signalov, slik in videa:.. 

Numerična analiza - povzetek 

 Uporaba vgrajenih funkcij  

 

 Uporaba pomoči 

 

 Analiza podatkov 

– Prilagajanje krivulj  

• Uporaba BFT  

• Interaktivno prilagajanje krivulj  

• Pridobivanje koeficientov polinomskega prilagajanja 

• Osnovne funkcije za prilagajanje krivulj  

 

Reševanje problemov – numerična analiza 



Univerza v Ljubljani  ..: Fakulteta za elektrotehniko:.. 

[LDOS]   ..: Laboratorij za digitalno obdelavo signalov, slik in videa:.. 

Avtomatizacija s skriptami 

 Različni tipi Matlab programov  

 

 Matlab Editor  

– Uporaba zgodovine ukazov  

– Uporaba komentarjev  

– Shranjevanje in poganjanje skript  

Reševanje problemov – skripte 



Univerza v Ljubljani  ..: Fakulteta za elektrotehniko:.. 

[LDOS]   ..: Laboratorij za digitalno obdelavo signalov, slik in videa:.. 

Matlab programi  

 Uporaba:  

– Lažje urejanje ukazov  

– Avtomatizacija opravil  

– Ustvarjanje lastnih aplikacij  

 

 Dva osnovna tipa:  

– Skripte (več ukazov združenih v skupino) 

– Funkcije  

 

 Sestavljanje programov – Matlab Editor  

– File > Open > Script  
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Univerza v Ljubljani  ..: Fakulteta za elektrotehniko:.. 

[LDOS]   ..: Laboratorij za digitalno obdelavo signalov, slik in videa:.. 

Matlab Editor 

 Vnos ukazov je enak kot v ukaznem oknu  
– Veljajo enaka sintaktična pravila  

 

 Pri sestavljanju programov uporabite zgodovino ukazov (kopiranje 
ukazov)  

 

 Uporaba komentarjev na primernih mestih – začnejo se z oznako % 
, označeni so z zeleno barvo 
– Razlaga kode  bolj razumljivo za druge in (po daljšem času 

neuporabe kode) tudi za avtorja 

 

 Shranjevanje programov:  
– File > Save / Save As …  

– Shranjeni programi imajo končnico .m  

– Privzeta lokacija je trenutna mapa, ki jo lahko spremenimo  

 

 Poganjanje skripte:  
– Pritisni F5 ali klik na gumb  

– Ime skripte vpišemo v ukazno okno brez končnice 
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Univerza v Ljubljani  ..: Fakulteta za elektrotehniko:.. 

[LDOS]   ..: Laboratorij za digitalno obdelavo signalov, slik in videa:.. 

Primer skripte 

Reševanje problemov – skripte 



Univerza v Ljubljani  ..: Fakulteta za elektrotehniko:.. 

[LDOS]   ..: Laboratorij za digitalno obdelavo signalov, slik in videa:.. 

Primer skripte 

1840 1860 1880 1900 1920 1940 1960 1980 2000 2020
-1.5

-1

-0.5

0

0.5

1

1840 1860 1880 1900 1920 1940 1960 1980 2000 2020
-0.8

-0.6

-0.4

-0.2

0

0.2

0.4

0.6

0.8

1850 1900 1950 2000
-0.8

-0.6

-0.4

-0.2

0

0.2

0.4

0.6

0.8

Reševanje problemov – skripte 



Univerza v Ljubljani  ..: Fakulteta za elektrotehniko:.. 

[LDOS]   ..: Laboratorij za digitalno obdelavo signalov, slik in videa:.. 

Avtomatizacija s skriptami - povzetek 

 Različni tipi Matlab programov  

 

 Uporaba Matlab Editor-ja  

– Uporaba zgodovine ukazov  

– Uporaba komentarjev  

– Shranjevanje in poganjanje skript  
 

Reševanje problemov – skripte 



Univerza v Ljubljani  ..: Fakulteta za elektrotehniko:.. 

[LDOS]   ..: Laboratorij za digitalno obdelavo signalov, slik in videa:.. 

Objava rezultatov  

 Objava Matlab programov in njihovih rezultatov 

– HTML, XML, DOC, PPT, LaTex formati  

– Uporaba celic pri programiranju (Cell feature) za avtomatsko objavo 

datoteke  

– Koda, komentarji in rezultati so predstavljeni v obliki strukturiranega 

poročila  

 

 HTML poročila  

– Vsebuje kodo s sintakso, komentarje in rezultate za vsako celico 

Reševanje problemov – objava rezultatov 



Univerza v Ljubljani  ..: Fakulteta za elektrotehniko:.. 

[LDOS]   ..: Laboratorij za digitalno obdelavo signalov, slik in videa:.. 

Generiranje poročila 

 Odpremo ustrezno skripto – vzemimo zadnji primer  

 

 Omogočiti moramo uporabo celic  

– V orodni vrstici Matlab Editorja izberemo:  

 Cell > Enable Cell Mode  

 

 Sledi delitev kode na sekcije – celice 

– Začetek celice označimo s simbolom %%, ki mu sledi naslov celice  

– Vstavimo jih kolikor se nam zdi potrebno  

– Vsaka celica bo v poročilu predstavljala podpoglavje 

 

 Po končani delitvi lahko končamo poročilo za objavo  

– V orodni vrstici Matlab Editorja izberemo: File > Publish 

– Izvrši se koda in ustvari se poročilo v izbranem formatu 

 

Reševanje problemov – objava rezultatov 



Univerza v Ljubljani  ..: Fakulteta za elektrotehniko:.. 

[LDOS]   ..: Laboratorij za digitalno obdelavo signalov, slik in videa:.. 

HTML poročila 

 Vsebuje kodo s sintakso, komentarje in rezultate za vsako celico  

 

 Naslovi celic so predstavljeni kot naslovi poglavij poročila, ustvari se 

ustrezno kazalo s povezavami  

 

 S klikanjem na povezave kazala se premikamo po poročilu v spletnem 

brskalniku  

 

 Koda je predstavljena v obarvanih odsekih za boljšo predstavo   

 

 Poročilo se shrani v trenutni delovni mapi v podmapo HTML  

 

 HTML je privzeti format poročil, ki ga lahko spremenimo:  

 Matlab Editor > File > Publish Configuration > Edit Publish 

Configuration  

Reševanje problemov – objava rezultatov 



Univerza v Ljubljani  ..: Fakulteta za elektrotehniko:.. 

[LDOS]   ..: Laboratorij za digitalno obdelavo signalov, slik in videa:.. 

Objava rezultatov - povzetek 

 Objava Matlab programov in njihovih rezultatov 

– HTML, XML, DOC, PPT, LaTex formati  

 

 Uporaba celic pri programiranju (Cell feature) za avtomatsko objavo 

datoteke  

 

 Izdelava HTML poročila  

– Vsebuje kodo s sintakso, komentarje in rezultate za vsako celico 
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Univerza v Ljubljani  ..: Fakulteta za elektrotehniko:.. 

[LDOS]   ..: Laboratorij za digitalno obdelavo signalov, slik in videa:.. 

Programiranje v Matlabu 

 Pisanje funkcij  

– Modularnost – problem razdelimo na manjše obvladljive dele  

– Ponovna uporaba kode za druge projekte  

 

 Uporaba zank in vejitev  

– Ponavljanje določenih odsekov kode  

– Logično odločanje 

 

Programiranje v Matlabu 



Univerza v Ljubljani  ..: Fakulteta za elektrotehniko:.. 

[LDOS]   ..: Laboratorij za digitalno obdelavo signalov, slik in videa:.. 

Integracija komponent 

Vgrajene funkcije 

in orodja 

Lastni programi 

Aplikacije 

Programiranje v Matlabu 



Univerza v Ljubljani  ..: Fakulteta za elektrotehniko:.. 

[LDOS]   ..: Laboratorij za digitalno obdelavo signalov, slik in videa:.. 

Pisanje funkcij  

 Sintaksa  

 

 Upravljanje z vhodnimi in izhodnimi spremenljivkami  

 

 Razlike med skriptami in funkcijami  

Programiranje v Matlabu – pisanje funkcij 



Univerza v Ljubljani  ..: Fakulteta za elektrotehniko:.. 

[LDOS]   ..: Laboratorij za digitalno obdelavo signalov, slik in videa:.. 

Sintaksa pisanja funkcij  

 Sintaksa pisanja je zelo podobna sintaksi klicanja funkcij  

  

 function izhod = Ime_funkcije(vhod) 

  function [izhod1, izhod2] = Ime_funkcije(vhod1, vhod2, …)  

 

 Izrazu s ključno besedo function pravimo deklaracija funkcije  

– Vedno je v prvi vrstici kode funkcije  

 

 Ime shranjene .m datoteke mora biti enako kot ime funkcije v deklaraciji!  

 

 Vhodne spremenljivke so uporabljene le kot vhodni parametri izračunov v 

funkciji! 

 

Programiranje v Matlabu – pisanje funkcij 



Univerza v Ljubljani  ..: Fakulteta za elektrotehniko:.. 

[LDOS]   ..: Laboratorij za digitalno obdelavo signalov, slik in videa:.. 

Primer  

Programiranje v Matlabu – pisanje funkcij 



Univerza v Ljubljani  ..: Fakulteta za elektrotehniko:.. 

[LDOS]   ..: Laboratorij za digitalno obdelavo signalov, slik in videa:.. 

Skripta vs. funkcija 

 Skripta  

– Zaporedje ukazov - enakovredno ukaznemu oknu 

– Avtomatizacija ponavljajočih se opravil   

– Vsi uporabljeni/generirani podatki so shranjeni v delovnem okolju 

 

 Funkcija:  

– Avtomatizacija opravil  

– Ob klicu moramo vnesti vhodne parametre 

– Rezultat so vedno izhodne spremenljivke  

– Uporabimo jih lahko za različne vhode brez spreminjanja kode – 

modularnost in splošna raba kode  

–  v delovno okolje se shranijo samo izhodne spremenljivke, vmesne 

spremenljivke (uporabljene samo v funkciji) se ne shranijo 

Programiranje v Matlabu – pisanje funkcij 



Univerza v Ljubljani  ..: Fakulteta za elektrotehniko:.. 

[LDOS]   ..: Laboratorij za digitalno obdelavo signalov, slik in videa:.. 

Zanke in vejitve 

 Vejitve  

– Pogojni stavek if – elseif – else  

 

 Zanke, ponovitveni stavki 

– While zanka  

– For zanka  

 

 

Programiranje v Matlabu – zanke in vejitve 



Univerza v Ljubljani  ..: Fakulteta za elektrotehniko:.. 

[LDOS]   ..: Laboratorij za digitalno obdelavo signalov, slik in videa:.. 

Pogojni stavek if – elseif – else  

if pogoj 1 == true  

 ukazi 1  

elseif pogoj 2 == true  

  ukazi 2  

else  

  ukazi 3 

end  

Pogoj 1 

Pogoj 2 

Ukazi 1 

Ukazi 2 

Ukazi 3 

end 

DA 

DA NE 

NE 

Programiranje v Matlabu – zanke in vejitve 



Univerza v Ljubljani  ..: Fakulteta za elektrotehniko:.. 

[LDOS]   ..: Laboratorij za digitalno obdelavo signalov, slik in videa:.. 

While zanka 

 Ponavljanje zaporedja ukazov 

dokler je izpolnjen dani pogoj  

 

while pogoj 

 ukazi  

end  

Pogoj 

Ukazi 

DA NE 

end 
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Univerza v Ljubljani  ..: Fakulteta za elektrotehniko:.. 

[LDOS]   ..: Laboratorij za digitalno obdelavo signalov, slik in videa:.. 

For zanka 

 Ponavljanje zaporedja ukazov za 

točno število iteracij  

 Možna je predčasna prekinitev 

 

for stevec = zac_vr:korak:kon_vr 

 ukazi  

end  

 

Stevec < 

kon_vr  

Ukazi 

DA NE 

end 

Stevec = zac_vr 
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Univerza v Ljubljani  ..: Fakulteta za elektrotehniko:.. 

[LDOS]   ..: Laboratorij za digitalno obdelavo signalov, slik in videa:.. 

Naloga 

 Z uporabo zank izriši animirano sinusno funkcijo:  
– x os: 0 – 2 pi, s korakom 0.1  

– y=sin(x) 

– Funkcija naj se izriše zaporedoma od prve do zadnje točke na x 
osi.   

 

 Namig:  
– Sliko je potrebno predhodno odpreti, definirati x in y skalo ter 

poskrbeti, da jo lahko dopolnjujemo: funkcije figure, axis in 
hold on  

– Uporabite funkcijo pause za zakasnitev 
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Univerza v Ljubljani  ..: Fakulteta za elektrotehniko:.. 

[LDOS]   ..: Laboratorij za digitalno obdelavo signalov, slik in videa:.. 

Programiranje – ključne besede 

 Spoznali smo osnovne ključne 

besede: for, if, elseif, else, end, while  

 

 Celoten seznam ključnih besed, ki so 

nam lahko v pomoč pri programiranju 
dobimo z ukazom iskeyword v 

ukaznem oknu  

Programiranje v Matlabu 



Univerza v Ljubljani  ..: Fakulteta za elektrotehniko:.. 

[LDOS]   ..: Laboratorij za digitalno obdelavo signalov, slik in videa:.. 

Programiranje v Matlabu – povzetek  

 Sintaksa za pisanje funkcij  

 

 Upravljanje z vhodnimi in izhodnimi spremenljivkami  

 

 Primerjava skript in funkcij  

 

 Uporaba odločitvenih/vejitvenih stavkov  

 

 Uporaba zank for in while  
 

Programiranje v Matlabu  



Univerza v Ljubljani  ..: Fakulteta za elektrotehniko:.. 

[LDOS]   ..: Laboratorij za digitalno obdelavo signalov, slik in videa:.. 

Hvala za pozornost  

 Matlab okolje  

 

 Matlab osnove  

 

 Reševanje problemov z Matlabom  

 

 Programiranje v Matlabu   

 


